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COPYRIGHT AND TRADEMARKS
Evolis © 2021. All rights reserved.
Users must observe the copyright regulations applicable in their country. This manual must not be photocopied, translated, reproduced or 
transmitted, in whole or in part, for any reason and by any electronic or mechanical means whatsoever without the express written consent of 
Evolis.
All the information contained in this document is subject to change without prior notice.
Evolis cannot be held liable for any errors that may be found in this manual, or for any loss or damage arising accidentally or as a result of 
dissemination or use of this manual.

, Evolis Premium Suite® and Evolis High Trust® are trademarks of Evolis. All other trademarks belong to their respective holders.

WARRANTY
Refer to the warranty notice for warranty terms and conditions and limitations. It is available on www.evolis.com.
Please register online at www.evolis.com to receive our special offers and general information.
Once on the website, click on Drivers and Support then on Register your printer and fill in all the fields, giving in particular the model and serial 
number found on your printer.

ENVIRONMENTAL INFORMATION
Evolis is committed to helping the environment by reducing the energy consumption of its products.

RECYCLING OF END-OF-LIFE PRODUCTS
The manufacture of the equipment that you have purchased required the extraction and use of natural resources. It may contain materials that 
are hazardous to health and the environment.
To prevent the dispersal of such materials into our environment and reduce the pressure on our natural resources, we recommend that you use 
existing collection systems. These systems will appropriately re-use or recycle most of the materials in your end-of-life equipment.
If you need further information on collection, re-use and recycling systems, contact your local or regional waste management body.

Do not hesitate to contact us to find out more by visiting our website at www.evolis.com or by emailing the following address: info@evolis.com.

ABOUT YOUR NEW PRINTER
Thank you for choosing an Evolis printer. Using your new printer, you will be able to create a wide variety of high-quality cards and badges which 
can be printed in various thicknesses, colours and styles. This printer uses consumables and accessories available from Evolis. 
For further details, visit our website at www.evolis.com.
To view all technical specifications, please refer to www.evolis.com.
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Certifications and declarations of conformity:
CE, UKCA, ICES, VCCI, BIS, CCC, KC, EAC, ROHS, 
FCC (Evolis contact: Evolis, Rising Sun Mills, 188 Valley St., Suite 421, RI 02909 Providence, evolisnortham@evolis.com)

Icons on the printer label:

Evaluation for apparatus only based on altitude not exceeding 2000m, therefore it’s the only operating condition applied for the equip-

ment. There may be some potential safety hazard if the equipment is used at altitude above 2000m. 

Evaluation for apparatus only based on temperate climate condition, therefore it’s the only operating condition applied for the equip-

ment. There may be some potential safety hazard if the equipment is used in tropical climate region.

Reminder to use existing collection facilities.

Dimensions

• Printer (HxWxD) without locking system and with 100-cards feeder: 246,2x 204.95x 381.2mm

Weight

4.11 kg

Connectivity

USB (1.0, 1.1, 2.0, 3.0), Ethernet, Wi-Fi (option)

Environmental Conditions

• Standard operating temperature: 15°C / 30 °C (59° / 86 °F)

• Min / Max operating temperature and humidity rate: 0° / 40° C (32° / 104° F) and 20% to 65% non-condensing

• Min/max storage temperature: –5°C / +70 °C (23° / 158 °F)

• Storage humidity: 20% to 70% without condensation

• Operating ventilation: free air

Electrical Information

• Power supply unit: 100-240 Volts AC, 50-60 Hz, 1.5A

• Printer: 24 Volts DC, 2.5 A

To view all technical specifications, please refer to www.evolis.com.
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Information providing further details or depth about specific points in the main text.

Indicates that failing to take the recommended action is liable to damage your printer.

A video showing the procedure is available on www.evolis.com website. 

NOTE

!

ICONS
The following icons are used in this manual to highlight important information:
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You will be asked for the full original packaging (outer box, inner wedges and protective bags) in the event that the printer is 
returned. If the printer is returned without its original packaging and components are damaged in transit, these components will 
no longer be covered by the warranty. You will be charged for new packaging for shipping the printer back to you.

If any of these components are missing, please contact your Evolis dealer.
Use only the power supply unit supplied with your Evolis printer.
Use only the USB cable supplied with your Evolis printer.

The Evolis printer must be placed in a dry location, protected from dust and drafts but well-ventilated. Make sure to keep your 
printer on a flat, sturdy surface able to bear its weight.

1 – GETTING STARTED
UNPACKING

Your printer is supplied with several accessories that we ask you to look at closely.
This list may vary depending on your location.

The printer is shipped in special packaging designed to prevent any damage in transit. If you notice any visible damage, do not hesitate to 
contact the shipper and immediately inform your Evolis dealer, who will tell you the procedure to follow.
Evolis takes great care over the quality of its packaging and we ask that you keep this packaging somewhere clean and dry.

Accessories supplied with your printer:

∙ Power supply unit – FSP type FSP060-RAAK3
∙ Mains power cable
∙ USB cable
∙ Reject box/Rear output hopper
∙ Starter cleaning kit
∙ Quick installation guide with QR code to access the driver
∙ Card designing software Cardpresso

!

!

NOTE
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A – Card input feeder (100 cards)

B – Internal output hopper

C – LCD Screen (option)

D – Push button

E - LED Control Panel

A

B

Access to the side panels of the machine and the option module fitting/removal areas is restricted to your retailer/installer or 
to experienced users. The machine should always be disconnected from the power supply (unplugged) before carrying out any 
work on it.

!

DESCRIPTION OF THE PRINTER AND ITS FUNCTIONS

C

D

E

If your machine is supplied with an LCD screen, please refer to the corresponding user guide to find out how to operate it.NOTE
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F – �Place for reject box (see section Managing 
the reject box/rear hopper)

G – �Location for security locking (option)

H – Power cable socket

I – Ethernet connector 

J – USB socket (type A)

K – USB socket (type B)

K J

I

H

G

F

L – Cleaning Roller

M - Side panel opening mechanism

N – Thermal print head with protective cover 

O – Card thickness adjustment gauge

L

N

Protective cover

O

M
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P Q

R

P – Printer serial number label

Q – Dust filter

R – Location for double-sided printing activation key (option)

S – Side panel opening mechanism

S
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To save energy, the printer will automatically switch itself to standby mode after 10 minutes of inactivity. The printer switches 
to hibernation mode after 30 minutes in standby mode.
The standby times can be configured in the Evolis Premium Suite. In standard standby mode, sending a print request restarts 
the printer and quickly pressing (for 1 second) on the button exits the printer from hibernation mode.

Before attempting any maintenance, always ensure that the power cable is unplugged. For your personal safety, ensure that 
the cable and power supply unit remain easy to access, especially in the event of an emergency.

∙ �Connect the power cable to the power supply unit, then plug the power supply unit connector into the printer.

∙ �Next, plug the end of the power cable into an earthed power socket.

!

The printer must be connected to a properly protected and earthed electrical installation.
FI: Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan.
NO: Apparatet må tilkoples jordet stikkontakt.
SE: Apparaten skall anslutas till jordat uttag.
DK: Printeren skal tilsluttes til en korrekt beskyttet og jordforbundet el-installtion.

!

NOTE

Connecting the Printer Power Supply Cable

INSTALLATION 

The printer is powered on: the control panel lights up showing the printer is working properly. 
If the control panel does not lightup, please check the installation. 
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Evolis Premium Suite® is an all-in-one driver software solution, which enhances the user experience by making interactions between printer and 
computer more intuitive. Its advanced features automate printer configuration. 

It includes:
∙ �A supervision of printers: printer status information, remaining ribbon capacity, etc.
∙ �A powerful tool for printer settings
∙ �A notification center to alert users when their intervention is required
∙ �A printer management and maintenance station
∙ �A series of wizards to guide you through cleaning and encoding operations, etc.
∙ �An encoding station (magnetic encoding, etc.)
∙ �A diagnostic tool

To install the print driver:
1. Go to the link dedicated to the driver (start.evolis.com/primacy2)

2. Download and launch the driver: Evolis Premium Suite®.

3. A programme will guide you through the entire installation process. 
You will have the possibility to select Standard or Minimal installation: standard installation is recommended as it includes notification and 
supervision features.

4. At the end of the installation process, you need to restart the computer.

5. Connect your computer to the printer trough the USB cable. 

Installing Evolis Premium Suite

Under no circumstances should you connect the USB data cable before 
installation of the printer driver is complete. 
Please follow the instructions of the wizard carefully.

!
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Connecting to a network 

All Evolis printers can be fitted with a TCP/IP network connection. This function is available as standard on Primacy.

Out of the box, the printer comes configured in DHCP mode (Dynamic Host Configuration Protocol), which means that its IP address is supplied 
by the network. 
In addition to these basic settings, the network administrator has the option of configuring the printer differently in order to comply with the 
constraints imposed by the corporate LAN:

∙ Printer connected in a subnet, in DHCP mode
∙ Printer connected to a subnet in fixed IP address mode, with WINS resolution
∙ Printer connected to a subnet in fixed IP address mode, without WINS resolution

The Ethernet connection wizard available in Evolis Premium Suite®  will automatically detect all installed Evolis printers.

The user-definable settings are:
∙ IP address of the printer
∙ Subnet mask
∙ Gateway
∙ WINS server

!

Evolis printers fitted with a TCP/IP network interface have an embedded http server.NOTE

Changing the printer’s basic settings without prior knowledge of the layout of the LAN in question or without genuine technical 
knowledge may result in a malfunction of the printer, and may even extend to more widespread failure of all or part of the LAN. 
Contact your System and Network Administrator before connecting to or changing the settings for your local area network.

For further details, refer to the Network Administrator Manual.
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The printer automatically recognises the ribbon inserted.

Insert the ribbon as shown.

Ribbons
Evolis original High Trust® ribbons optimise your printer’s operation and avoid causing damage to it. The use of ribbons from other suppliers is 
liable to damage your printer and voids the manufacturer’s warranty for the printer.
For optimum print quality, Evolis recommends that the printer is fully cleaned every time the ribbon is changed. See the Advanced User Guide.

Fitting the ribbon

Open the cover. Close the cover and press until a click is 
heard.

NOTE

1 2 3

NOTE
Primacy 2 ribbons are different from Primacy 1 ribbons. They cannot be swapped. 
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For optimum quality, the cards used must be ISO 7810 certified.
Use only the card types recommended by Evolis.
Do not touch the printable surface of the cards in order to preserve print quality.
Do not use cards that have been damaged, folded, embossed or dropped on the floor.
Keep your cards protected from dust.

Inserting Cards

Open the card feeder. Insert the cards, a maximum of 100 cards of thickness 
0.76 mm. Ensure the cards are positioned as 
illustrated in the diagram.

2 Close the feeder.

NOTE

1 3

100
x0.76mm
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Removing printed cards

Once the print cycle is complete, cards are delivered into the output hopper below the card feeder. 
This output hopper is designed to collect printed and/or encoded cards. 

The output hopper has a maximum capacity of 100 x 0.76 mm cards. 

100
x0.76mm

In case you have chosen the locking system option, maximum capacity is reduced to around 50 x 0.76 mm cards.NOTE
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To adjust card thickness:

Open the card feeder and remove cards 
if necessary

Close the feeder

Adjust the thickness of the cards used by 
moving the gauge from right to left to the 
desired card thickness.

Adjusting card thickness 
The printer is equipped with a manual card thickness adjustment mechanism which can be reached through the card feeder when open. 
The printer accepts cards between 0.25 mm and 1.25 mm thick (10 to 50 mil). The factory setting is 0.76 mm.

You can find the card thicknesses on the card box:NOTE

1

2

3
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The reject box can be used as a hopper to optimise the production flow of cards when continuous ribbons are used. 
Preloading cards enables to optimise the production flow. To activate this feature, go to Evolis Premium Suite and click the printer 
name>Printer settings>Printing>Resolution and Speed>Enable automatic card preloading.

Managing the reject box/rear output hopper

The printer is fitted with a removable reject box which is positioned behind it.
The reject box can hold 50 cards (0.76 mm - 30 mil).

To empty it, simply open the box and remove the cards in it.
It is recommended to empty this box regularly.

50
x0.76mm

NOTE
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2 – MANAGING PRINT SETTINGS
ACCESSING SETTINGS

Evolis Premium Suite enables to change specific predefined settings through its user-friendly interface on Windows platforms.

To access this application:

- �Double-click on Evolis Premium Suite shortcut or, from the Start button on the bottom left of your screen in the Windows task bar, select 

All programs>Evolis Card Printer>Evolis Premium Suite

- The application displays all connected Evolis printers. Select the desired printer.

You can change the settings through Printer Settings tab.

Please do not hesitate to contact your Evolis reseller for any advice and assistance needed before making any change of 
setting.

NOTE

NOTE On Macintosh platforms, please refer to Macintosh driver User Guide. 
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Once the ribbon is installed, your Evolis printer automatically adapts its parameters and settings to suit the ribbon.

For your first printings, you can manage the following settings. For more advanced printings, please refer to the Advanced User Guide.	

Action Setting in Evolis Premium Suite
Go to Ribbon tab and click on Enable duplex printing if you want to 
use the double-side printing feature. 

Go to Card tab and select the orientation: Landscape or Portrait

Click on Display advanced settings (on the right part of the 
window) to unhide more precise parameters.

Go to Card input/output and select the adequate options

From Resolution and Speed tab, change the resolution if needed:

From Colors tab, you can manage black dots on the card:

From Overlay tab, you can manage the areas of the card to cover 

with overlay: 

ESSENTIAL SETTINGS



PRIMACY 2

20

3 – PRINTING AND INTERACTING WITH THE PRINTER
PRINTING A CARD
A large number of applications allow documents to be printed (for example MS Word, MS Access, MS Excel, MS PowerPoint).

Please read the following examples to gain familiarity with the layout of a card and configuration of its formatting and printing.

On Microsoft® Word
1. After having set the Evolis printer as the default:

∙ Start the MS Word application.

∙ Select Landscape in the Orientation section.

∙ Change the size of your document by selecting the type CR80 (or by customising the document with the dimensions 8.6 cm x 5.4 cm and 
margins of 0.1 cm).

2. Customise your card by adding the various items that go to make up a card: logo and illustration, identification photo, fixed and variable texts, 
barcode, etc.
3. Click on File and then on Print.

On Cardpresso 

1. Open Cardpresso application and select CR80 card type. 

2. The card design window is displayed. You are ready to customise your card by adding the various items that go to make up a card: logo and 
illustration, identification photo, fixed and variable texts, barcode, etc.

3. Click on File>Print, select Primacy 2 printer and click on Print. 

NOTE For more information, please refer to FAQ on Evolis website or Cardpresso embedded Help.

On TextEdit 

1. Open TextEdit application
2. Go to File> Page Setup>Paper Size>Manage Custom Sizes
3. Click on + and add a new format as follows: width : 55mm, height : 86mm, top : 0mm, left : 0mm, right : 0mm, bottom : 0mm
4. Save the new format with the name Card and click on OK
5. Close Text Edit
6. Go to System Preferences and select Printers and Scanners. On Default paper size, select Card
7. Go back to TextEdit and design your card. 
8. Click on File>Print and select Primacy 2 printer.
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USING THE CONTROL PANELS

LED Control panel

OFF

STEADY LIGHT

FLASHING

PRINTER READY

• �The printer is ready 
to receive data.

PROCESSING

• The printer is receiving 
data.

RIBBON

• No ribbon in the printer.
• End of ribbon.
• The ribbon is not correctly fitted.
• The ribbon is torn.
• The ribbon is not recognised.

Check the condition of the ribbon in the printer. If 
you have a print job in progress, this restarts with 
a new card.

CARDS

• No cards in the card feeder.
Put cards back into the feeder – the process starts 
again.

• Card loading error.
Check cards have been loaded. For any other 
problems contact your Evolis dealer.

PRINTER COVER OPEN 

• The printer cover is open.
Close the cover again. The printer starts up.

MECHANICAL ERROR

• Card jammed in the printer.
• Mechanical component fault.

Open the cover and hold down the pushbutton 
in order to eject the jammed card. 
If the problem persists, contact your Evolis 
dealer for assistance.



PRIMACY 2

22

COOLING MODE

• �The cooling system has been activated.
The printer pauses for a few seconds and 
restarts once it has returned to its normal 
operating temperature.

FIRMWARE UPDATE

• �The printer is updating its firmware.
The printer restarts following the update.

ADVANCED CLEANING

• �The printer requires advanced cleaning.

(See the Advanced User Guide)

ROUTINE CLEANING
(after 1,000 cards have been inserted)

• �The printer must be cleaned.

(See the Advanced User Guide)

CLEANING
(after 1,200 cards have been inserted)

• �The printer must be cleaned to avoid the 
risk of the warranty being voided.

(See the Advanced User Guide)

Wi-Fi IS ON (option)

• �The wireless (Wi-Fi) connection has 
been enabled.

You can start printing.
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LCD screen

- Green color: printer is ready to print or in the process of printing, encoding, cleaning, etc.

LCD screen is touch-sensitive: it enables easy interaction with the printer. 

Useful messages on the printer processes are displayed. 
They enable you to take actions and perform a good supervision of your printing jobs.

There are various types of statuses:
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For more details, please refer to LCD screen user guide.NOTE

- Orange or red color: processes cannot be performed due to a small or serious issue 

Scan the flash code to access information on the Web that will help you to solve the issue.  

- Red color: processes cannot be performed due to a serious issue. The user action is needed:

Scan the flash code 
to access help

Launch the 
process again

Cancel the process
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Pop-ups 
Evolis Premium Suite offers a service allowing the printer to communicate with the user through notifications.

There are several types of notifications:
∙ Messages about the maintenance of the printer.
∙ Messages and alerts associated with the ribbons, their compatibility with your printer or the nature of your print requests.
∙ Warnings about problems which have stopped the printer.

When the Evolis Premium Suite is active, a small icon is displayed in the bar on the bottom right of your computer screen.

The colour of the icon varies according to the status of the printer:
∙ Green: Printer ready
∙ Orange: Information message issued – printing stopped
∙ Red: Warning message issued – printing stopped
∙ Grey: Printer in hibernation mode, disconnected or communication interrupted.

When a notification is issued, it is displayed in a window of the following type:

Cancel the printing task

Notifications can be disabled by clicking User Preferences then by unticking the Enable notifications button.

Interrupting the pop-ups service is only recommended if there is a conflict with other applications installed on your computer. We 
remind you that the pop-ups ervice is the best way to monitor your printer adequately from your workstation.

NOTE

Get additional help from Evolis support site.
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APPENDIX 
DECLARATIONS OF CONFORMITY
In this section, you will find the certifications for your Evolis printer.

Declarations of conformity
Concerning Safety and Electromagnetic Compatibility of Radio Equipment (RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives) and (RoHS3) 

2015/863/EU:

Manufacturer name:	 Evolis

Manufacturer address:	 14, avenue de la Fontaine
Z.I. Angers Beaucouzé

49070 Beaucouzé, France

Equipment name:	 Primacy 2

Year of manufacture:	 2021

I, the undersigned,

Laurent Godard, 

Declare under my own responsibility that the product here above described complies with the essential applicable requirements, (particularly with those of the 

RED 2014/53/EU, LVD 2014/35/EU, EMC 2014/30/EU Directives and (RoHS3) 2015/863/EU as follows:

Article 3.1 a: (electromagnetic compatibility protection requirement)

Safety standard applied	 EN62368-1: 2014

EN50364: 2010

Article 3.1 b: (electromagnetic compatibility protection requirements)

EMC standard applied	 EN55032: 2012

EN55024: 2010

EN61000-3-2: 2014

EN61000-3-3: 2013

EN301489-3: 2013 (VI.6.1)

Article 3.2: (Good use of the radio frequency spectrum to avoid undesirable interferences)

EMC standard applied	 EN300330-2 V1.6.1
Full name: Laurent Godard

Position: R&D Director

Date: : 2021

Signature:

EUROPE - Norway Only: This product is designed for IT power system with phase-to-phase voltage 230 V. Earth grounding is via the polarised, 3-wire power cord.

FI: “Laite on liitettävä suojamaadoitus koskettimilla varustettuun pistorasiaan”

SE: “Apparaten skall anslutas till jordat uttag”

NO: “Apparatet må tilkoples jordet stikkontakt”

DK : „Apparatets stikprop skal tilsluttes en stikkontact med  jord, som giver forbindelse til stikproppens jord“.
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VCCI (For Japan)
This is a Class B product based on the standard of the Voluntary Control Council 
for Interference from Information Technology Equipment (VCCI). If this is used 
near a radio or television receiver in a domestic environment, it may cause radio 
interference. Install and use the equipment according to the instruction manual.

ICES additional information:
This device contains licence-exempt transmitter(s)/receiver(s) that comply with Innovation, Science 
and Economic Development Canada’s licence-exempt RSS(s). Operation is subject to the following two 
conditions:

1. This device may not cause interference.
2. This device must accept any interference, including interference that may cause undesired 
operation of the device.

This equipment complies with RSS102’s radiation exposure limits set forth for an uncontrolled 
environment under the following conditions:

1. This equipment should be installed and operated such that a minimum separation distance of 
20cm is maintained between the radiator (antenna) and user’s/nearby person’s body at all times.
2. This transmitter must not be co-located or operating in conjunction with any other antenna or 
transmitter

FCC additional information:
• Pursuant to Part 15.21 of the FCC Rules, any changes or modifications made to this equipment without 

the express, written consent of the company Evolis may cause harmful interference and void the FCC 

authorization to operate this equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference in a residential 

installation. This equipment generates uses and can radiate radio frequency energy and, if not installed 

and used in accordance with the instructions, may cause harmful interference to radio communications. 

However, there is no guarantee that interference will not occur in a particular installation. If this equipment 

does cause harmful interference to radio or television reception, which can be determined by turning the 

equipment off and on, the user is encouraged to try to correct the interference's by one or more of the 

following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipment and the receiver.

-Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

-Consult the dealer or an experienced radio/TV technician for help.

This equipment complies with FCC’s radiation exposure limits set forth for an uncontrolled environment 

under the following conditions :

1. This equipment should be installed and operated such that a minimum separation distance of 20cm is 

maintained between the radiator (antenna) and user’s/nearby person’s body at all times.

2. This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

FCC Statement (For U.S.A.)
Federal Communications Commission Radio Frequency Interferences Statement

Primacy 2 model conforms to the following specifications: FCC Part 15, Subpart A, Section 

15.107(a) and Section 15.109(a) Class B digital device.

Supplemental information:

This equipment has been tested and finds to comply with the limits for a Class B digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this requirement does cause harmful interference to radio or television reception, which can 
be determine by turning the equipment off and on, the user is encouraged to try to correct the interference’s 
by one or more of the following measures: 
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Use of a shielded cable is required to comply within Class B limits of Part 15 of FCC Rules.
Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not expressly 
approved by Evolis may cause, harmful interference and void the FCC authorization to operate this 
equipment.
It is recommended to respect a distance of 20 cm between user and RFID module when the module is 
powered. 
This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the 
following two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device.


